Practice Block Paraboias

Activity 1: Parabolas (vertex form)

e Time frame: 10 min
e Overview
o Discuss the vertex form of a parabola
o Guided construction of sliders to graph a vertex form of a parabolic
function

Discussion:

 In general what is the factored form of a parabolic function?
e How do the values affect the graph of the function?

Guided construction of sliders to graph a vertex form of a parabolic function

e Preparations
o Open new GeoGebra file
o Show algebra window
o Show coordinate axes
o Show grid (optional)

e Construction steps
1 as2 Make three sliders named: a, h, and k

2 In the input field enter: f(x)=a (x — h)"2+k

Enter into text box: “f(x)="+a+"(x-“+h+")A2+"+k
3 ABC Red: represents the static text (without the
quotation marks)

e Check construction
o Drag the sliders and observe the changes in the graph, equation (algebra
window), and the dynamic text.

e Properties
o Change the color of the function and the text to match
o - Change font size and style
o Change style of curve (thickness, solid, dashed, etc...)



Exeter Computer Lab — Parabolas —Vertex Form
After starting the program GeoGebra, choose Open [T
under the File menu, and choose the file s
Parabvix4.ggb. When the file opens up, you |' "

h«0

should see a picture of a parabola on an axis | —*;  \'
system that looks like the one at right. The three |
sliders are used to change the values of a, h, and k
the equation y = a(x—h)* +k.

The diagram will change dynamically as you |- =7
change the value of the three parameters. I T e
1. To change the value for any of the three

parameters, simply click on the point labeled a, h, or k, and then slide it back and forth

on the horizontal line containing that point. Try it by changing the value of a while
leaving h and k at 0.0.
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a) What happens to the curve when the value of a increases so that it is greater than
one? ‘

b) What happens to the curve when the value of a decreases, but stays positive?
c) What happens to the curve when the value of a becomes negative?
d) What happens to the curve when the value of a becomes zero?

2. Change the value of h by dragging on the appropriate slider.

a) What happens to the curve when the value of h changes? Describe in reasonable
detail.

b) Change the h and a sliders so as to display the parabola with vertex (2,0) and y-
intercept (0,8). Write down an equation for this parabola in vertex form.



c) Use the sliders to display the parabola with the same shape as the one in b) above,
but with vertex at (-4, 0). Write an equation of this parabola, and determine its y-
intercept algebraically.

d) Use the a and h sliders to draw the parabola opening down with the same shape as
the ones in b) and c), and whose vertex is at (2, 0). Write an equation of this parabola.

3. Change the value of k by dragging on the appropriate slider.

a) What happens to the curve when k changes? Describe in reasonable detail.

b) Change the h, k, and a sliders so as to display the parabola with vertex (-1, 2) and y-
intercept (0, 5). Write down an equation in vertex form for this parabola.

c) Use the sliders to display the parabola with the same shape as the one in b) above,
but with vertex at (5, -2). Write down an equation of this parabola, and determine its y-
intercept even though it may not be in view.

4. First determine the equation of the following parabolas in the space below. Then,
adjust the sliders appropriately to check to see if you have the correct parabola.

a) Vertex (1, -1), y-intercept (0, 4).

b) Vertex (-4, -3), contains point (-2, -1).

c) Vertex (5, 2), contains point (1, -6).



Activity 2: Parabolas (factored form)

e Time frame: 10 min
e Overview
o Discuss the factored form of a parabola
o Guided construction of sliders to graph a factored form of a
parabolic function

Discussion:

¢ In general what is the factored form of a parabolic function?
e How do the values affect the graph of the function?

Guided construction of sliders to graph a factored form of a parabolic function

e Preparations
o Open new GeoGebra file
o Show algebra window
o Show coordinate axes
o Show grid (optional)

e Construction steps
1 232 Make three sliders named: a, p, and g

2 In the input field enter: f(x)=a (x-p) (x-q)

Enter into text box: “f(x)="+a+"(x-“+p+")(x-“+q+")"
3 ABC Red: represents the static text (without the
quotation marks)

e Check construction
o Drag the sliders and observe the changes in the graph, equation (algebra
window), and the dynamic text.

e Properties
o Change the color of the function and the text to match
o Change font size and style
o Change style of curve (thickness, solid, dashed, etc...)



Exeter Computer Lab — Parabolas — Factored Form

After starting the program GeoGebra, choose Open e UNder
the File menu, and choose the file Parabfct4.ggb. Y When
the file opens up, you should see a picture of a :

parabola on an axis system that looks like the one at X right.
The three sliders are to be used to change the values ,‘ of a,
p, and q in the equation y=a(x—p)(x—gq). The =

diagram will change dynamically as you change the by value

of the three parameters. :

1. To change the value for any of the three parameters, simply click on the point
labeled a, p, or g, and then slide it back and forth on the horizontal line containing that
point. Try it by changing the value of a while leaving p and q at 0.0.

a) What happens to the curve when the value of a increases so that it is greater than
one?

b) What happens to the curve when the value of a decreases, but stays positive?

c) What happens to the curve when the value of a becomes negative?
d) What happens to the curve when the value of a becomes zero?

2. Change the value of p by dragging on the appropriate slider.

a) What happens to the curve when the value of p changes? Describe in reasonable
detail.

b) Change the p and a sliders so as to display the parabola with x-intercepts at (0,0)
and (4,0), and a vertex at (2, -8). Write down an equation in factored form for this
parabola.

c) Use the sliders to display the parabola with the same shape as the one in b) above,



but with x-intercepts at (0,0) and (-3,0). Write an equation of this parabola, and
determine its vertex.

d) Use the a and p sliders to draw the parabola opening down with the same shape as
the ones in b) and c), and whose x-intercepts are (0,0) and (6,0). Write an equation of
this parabola, and determine its vertex.

3. Change the value of g by dragging on the appropriate slider.

a) What happens to the curve when g changes? Describe in reasonable detail.

b) Change the a, p, and g sliders so as to display the parabola with x-intercepts at (2, 0)
and (-2, 0), with vertex at (0, 4). Write down an equation in factored form for this
parabola. '

c) Use the sliders to display the parabola with the same shape as the one in b) above,
but with x-intercepts at (-3, 0) and (5, 0). Write down an equation of this parabola, and
determine its vertex even though it may not be in view. Does the computer display give
a perfectly accurate value for the vertex? Explain.

4. First determine the equation of the following parabolas in the space below. Then,
adjust the sliders appropriately to check to see if you have the correct parabola.

a) x-intercepts at (-4, 0) and (6, 0), and Vertex (1, -5).

b) x-intercepts at (-5, 0) and (1, 0), and containing the point (3, 32)

c) x-intercepts at (0, 0) and (-3, 0), and containing the point (2, 3)



Activity 3: Parabola (standard-form)

Classification: Basic task

e Time frame: 10 min
e Overview
o Discuss the factored form of a parabola
o Guided construction of sliders to graph a factored form of a
parabolic function

Discussion:

¢ In general what is the factored form of a parabolic function?
e How do the values affect the graph of the function?

Guided construction of sliders to graph a standard form of a parabolic function

e Preparations :
o Open new GeoGebra file
o Show algebra window
o Show coordinate axes
o Show grid (optional)

e Construction process

1. Make three sliders called a, b, and ¢

2. Enter into the input field: f(x) = ax’ +bx+c
3. Insert dynamic text: “f(x) ="+a+’xN2} +"+b+"x +’+C

e Check construction
o Drag the sliders and observe the changes in the graph, equation (algebra
window), and the dynamic text.

e Properties
o Change the color of the function and the text to match
o Change font size and style
o Change style of curve (thickness, solid, dashed, etc...)



Exeter Computer Lab — Parabolas — Standard Form

After starting the program GeoGebra, choose Open

z..: ;:nrmaw]«um; f under

the File menu, and choose the file Parabstd.ggb. When
the file opens up, you should see a picture of a

parabola on an axis system that looks like the one at
right. The three sliders are to be used to change the values

of a, b, and c in the equation y=ax’ +bx+c. The |*7=5 s fmioeeys
diagram will change dynamically as you change the | R i value
of the three parameters. ‘ :
1. To change the value for any of the three parameters S|mply click on the point
labeled a, b, or ¢, and then slide it back and forth on the horizontal line containing that
point. Try it by changing the value of a while leaving b and c at 0.0.

a) What happens to the curve when the value of a increases so that it is greater than
one?

b) What happens to the curve when the value of a decreases, but stays positive?
c) What happens to the curve when the value of a becomes negative?

d) What happens to the curve when the value of a becomes zero?

2. Change the value of ¢ by dragging on the appropriate slider.

a) What happens to the curve when the value of ¢ changes? Describe in reasonable
detail.

b) Change the ¢ and a sliders so as to display the parabola with a vertex at (0, 2) and
an x-intercept of (1, 0). Write down an equation in standard form for this parabola.

c) Use the sliders to display the parabola with the same shape as the one in b) above,
but with vertex at (0, 5). Write an equation of this parabola, in standard form.

d) Use the a and c sliders to draw the parabola opening up with the same shape as the
ones in b) and c¢), and whose x-intercepts are (2, 0) and (-2, 0). Write an equation of this
parabola, and determine its vertex even if it is not in your viewing window.



3. Change the value of b by dragging on the appropriate slider.

a) What happens to the curve when b changes? Describe in reasonable detail.

b) Change the a, b, and c sliders so as to display a parabola with axis of symmetry at x
= 2 and passing through the origin. There are an infinite number of examples to choose
from, write down an equation in standard form for two of them.

c) Use the sliders to display the parabola with the same shape as y=0.5x*, but with
vertex at (-1, 4). Determine the x-intercepts for this parabola.

4. First determine the equation of the following parabolas in the space below. Then,
adjust the sliders appropriately to check to see if you have the correct parabola.

a) x-intercepts at (-1, 0) and (3, 0), and Vertex (1, 2).

b) Vertex at (-2, 3), and contains the point (0, 11).

c) Contains the three points (0, -4), (1, -1), and (2, 1).




Activity 4: Geometric Construction of Parabola

Time frame: 20 min

Overview
o Discuss the geometric definition of a parabola
o Guided construction of a parabola




Guided construction of a parabola

¢ Preparations
o Open new GeoGebra file
o Show algebra window and hide coordinate axes if necessary
o Change labeling setting to New points only

o Construction steps
o™ Point A (focus)

[N

Line (directrix, Line BC)

Point D on Line BC

Segment AD

Perpendicularly bisect Segment AD

Thru Point D perpendicular to Line BC

Intersect the perpendicular bisector and perpendicular line to Line
BC, Point E :

Segment AE

o N oo o ok~ W DN

YENDEUSINTIRN

Locus of E as D moves

A D B

e Check construction
o Move the focus and directrix to make sure the locus is a parabola
o Show navigation bar to review construction step-by-step



Discussion :
o How can we justify that Point E is equidistant from the directrix and the
focus?
o Discuss what happens when distance from the focus and directrix change.
o Trace function before using the locus tool

To sketch the specific parabola whose directrix is y = -1, and whose focus is at
(0,1), first show the axes and grid. Also, under the Options menu change point
capturing to on (grid). It should now be easy to drag points A and B to locations
on the line y = -1, and to drag the focus C to the location (0,1). Now move the
focus to (0,2), and the directrix to y = -2? What do you notice happened to the
equation*? Repeat this process for a couple of more examples and try and
predict what is going on with the coefficient of the x-squared term in the equation,
and the distance between the focus and the directrix.

*To view the equation we are going to have to actually construct the conic. Use the
point tool and put 5 points on the locus. Then use the ‘conic through five points’ tool
to construct the conic. Once you see the equation of the parabola click on the
properties of the equation to change its form to 'y = ax"2+bx+c’. You may also have
to change the decimal places in the Options menu.

How would you describe the relationship of the non-vertical line through E to the
parabolic curve? If you said that this line is the fangent line to the curve, you are
absolutely right. Let's examine the remarkable reflection property of parabolas
that is the key to most of their everyday practical uses. First, hide the axes, grid,
Segment DC, and Segment EC. Your picture should now look like the below.




o Reflect Line DE with respect to the tangent line. A new line is constructed, and
for better contrast, change its color to red. Drag D back and forth and notice a very
important property of this reflected line. It always passes through the focus of the
parabola! Feel free to drag A, B, or C to different positions. Imagine that the line through
D represents a light ray, a sound wave, or anything else. If it is traveling along a path
perpendicular to the directrix of the parabola, it will reflect off the parabola to its focus. It
is this important property that is used in satellite dishes, headlights in cars, and in many
other applications.




Activity: Geometric Construction of an Ellipse

Time frame: 20 min
Overview

o Discuss the geometric definition of a parabola
o Guided construction of a parabola

Discussion:

What is the geometric definition of an ellipse?

Guided construction of a parabola

1

2
3
4

Preparations

o Open new GeoGebra file
o Show algebra window and hide coordinate axes if necessary
o Change labeling setting to New points only

Construction steps
A/ Circle, centered at A containing B

o™ Point C on Circle A & Point D inside the circle
<  Segment CD & Segment AC

‘:}3\' Perpendicular Bisector of Segment CD
Points of intersection E and F between segment CD and the

X perpendicular bisector of CD and segment AC and the

perpendicular bisector of CD

Your construction should look something like this.




Justification of the construction:

Distance FC equals FD by virtue of F being on the perpendicular bisector. Therefore,
AF + FC = AF + FD = radius of the circle AC. This is true no matter what the position
of C as it moves around the circle. Construct segment FD and make appropriate
measurements to verify.

Right click on point F and select Trace On. Slowly drag C around the circle to see a
temporary trace of the path of point F. Right click on F again and deselect Trace On,
now to see a permanent path of Point F select the locus tool and click on Point F and
then Point C.

The curve constructed is an ellipse. Points A and D are the foci of the ellipse, and the
radius of the circle AC is the length of the major axis. Can you explain why?

Drag on A, B, C, and D to observe the changes in the diagram. Do you see the
important property that the perpendicular bisector of CD has? Hopefully you have
observed that this line is the tangent line to the ellipse at point F. To see a nice visual of
this right click on the tangent line and select Trace On, observe what happens as Point
C moves around the circle.

Ellipses have a special reflection property similar to parabolas that involves the foci. To
demonstrate this reflection property, hide everything in the sketch but the ellipse, the
tangent line, the foci A and D, and points F and C. Construct line AF. Reflect line AF
using the tangent line as a line of reflection. Notice how the reflection always passes
through the other focus D as you drag on point C and thus move F around the ellipse.



